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1 General aspects 

1.1 Introduction 
This manual is an essential guide to successful and 
safe use of the CFC Com1 software in conjunction with 
a CFC x000 compact flame detector.  

Any modification to the CFC x000 parameters may only 
be made after the operating instructions of the compact 
flame controller have been read carefully. 

This manual does not contain the original operating in-
structions and only explains the possibilities of parameter-
ization with the CFC Com1 software. 

Current software version: 1.89 
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2 Installation 

2.1 Installation of the software 

2.1.1 System requirements 

The minimum and recommended hard and software re-
quirements can be obtained from the following table. 

Minimum Recommended

CPU Pentium 200 at least P3 with 
600 MHz 

RAM 98 MB 256 MB 

Graphic card Standard VGA 

Screen resolu-
tion 

800 x 600 1024 x 768 

Free memory  1 GB 

Interfaces RS-232 RS-232, USB 2.0

Operating sys-
tem 

from Win XP tested up to 
Windows 10 

The data logger function can only be used if the users is 
logged onto the computer as administrator. 
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2.1.2 Run setup 

There are two ways of installing the software: 

 Installing the software via Setup.exe that is stored in
the
CFC_Com_1_Ver1.xxx\Installer_DE\Volume
folder.

 Using the autostart function of the CD-ROM drive. In
this case, the CD starts automatically and a dialogue
window is opened. Then click on the Start installation
button.

After successful execution of the installation, the following 
installation folders are suggested. Clicking the Search 
field of a folder allows you to assign a different file name. 
Clicking Next opens the licence agreement. The licence 
agreements for both LabView and CFC Com1 must be 
accepted successively.  
Finally, checks are made for existing software compo-
nents. Clicking next starts installation of the files into the 
specified folder. 
The install programme subsequently reports that the en-
tire installation is completed after clicking Finished. 
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2.2 Connecting to the computer 
Connect the compact flame controller to the 
computer using a special data cable (1). The 
data cable consists of a 9 pin SUB-D plug (2) 
for connecting to the COM interface (3) of the 
computer and an IR interface in the SUB-D 
housing (4) for connecting to the compact 
flame controller (5). For computers without a 
serial interface, it is possible to use a 
USB/RS232 converter cable (accessory).A ca-
ble with direct USB connection is in prepara-
tion. 

The compact flame controller must be con-
nected to the power supply (24 V DC). 

After connecting the compact flame controller 
to the computer and installing the software, 
the program can be started. 

1 

1 

2 

4 

5 

3 
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2.3 Programme for the CFC x000 

2.3.1 Starting the program 

Start the programme by double-clicking the CFC Com1 
icon. 
The illustrated CFC Com1 interface is displayed. The res-
olution cannot be changed. 
The following window opens: 

2.3.2 Selecting the interface 

No interface is activated by default. This setting can be 
changed by clicking the Interface menu item in the Set-
tings menu. All active COM interfaces are displayed. 
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2.3.3 Data transfer 

Data transfer takes place immediately after selecting the 
correct interface. 

During data transfer, the software automatically 
detects which CFC type is connected. 

After starting, it is initially only possible to receive 
data. Settings or parameters can only be changed 
after entering the corresponding serial number and 
may only be performed by appropriately qualified 
and trained specialist staff! 

Click the Info item in the Help menu to obtain infor-
mation on the software version. 
Close the window with the OK button or the ESC 
key. 
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3 Visualization 
The user interface is dependent on the connected 
CFC type. 

View for the CFC 1000: 

View for CFC 2000: 

In the case of the CFC1000, only amplitude evaluation is 
displayed and only one parameter level is available. The 
frequency evaluation, DC raw signal evaluation and a 
second parameter evaluation is also visualised and ena-
bled on devices after CFC 2000. These differences in dis-
play result from the different range of functions of the de-
vice types. The sections that do not apply to the CFC 
1000 are marked in the following description. 
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3.1 Displaying the flame intensity 
The upper window on the left-hand side of the screen dis-
plays the intensity of the measured flame radiation that 
has already been processed for evaluation by the ampli-
fier and filter circuits. The radiation intensity is repre-
sented with the current threshold values by the amplitude 
evaluation in a diagram. Black always indicates the cur-
rent actual value. Green indicates the set switch-on 
threshold and red indicates the switch-off threshold. The 
corresponding numerical values are displayed on the right 
of the diagram. The colours correspond to the colours in 
the diagram. Pressing the L button increases the size of 
the diagram. The screenshot button used for saving the 
currently-displayed diagram as image file is located in the 
bottom left  corner. Pressing L button returns to the nor-
mal view.  
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3.2 Displaying the frequency evaluation 
The middle window on the left-hand side of the screen 
displays the frequency of the flame modulation. The main 
modulation frequency of the flame or combustion to be 
monitored is determined by means of a specially devel-
oped frequency analysis. 
As with the intensity display, the threshold values are 
again displayed in green and red and the actual value in 
black. This frequency can be used as an additional crite-
rion for monitoring and evaluation. All three values are 
also displayed as numerical values on the right-hand side 
of the diagram. 
Here, the diagram is also increased in size with the help 
of the L button and screenshots are activated by the S 
button. Pressing the L button again returns to the normal 
view. 

Not activated for the CFC 1000! 
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3.2.1 Histogram function 

If the histogram button is pressed, the frequency evalu-
ation display changes from the current value to fre-
quency distribution per unit of time. 

If the histogram button is active, the Reset button appears 
under it. If this is activated, the collected frequency distri-
bution data is deleted and the distribution is redisplayed 
subject to the current frequencies.  
The size of the histogram can also be increased or de-
creased by pressing the L button. 

In addition to the already familiar L and S buttons, there is 
also the R button in this view. It also resets the frequency 
history. 

Not activated for the CFC 1000! 
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3.3 Displaying the DC raw signal 
The lower window on the left-hand side of the screen dis-
plays the DC raw signal evaluation. The radiation  inten-
sity or the radiation level is visualised. The switching 
threshold of the DC raw signal has no influence on the 
"ON" or "OFF" signal flame. 
This frequency can be used as an additional criterion for 
monitoring and evaluation. All three values are displayed 
as numerical values on the right-hand side of the diagram. 

Pressing the L button increases the size of the diagram. 
The screenshot button used for saving the currently-dis-
played diagram as file is located in the bottom left  corner. 
Pressing L button returns to the normal view. 

The DC raw signal is only visualised by compact 
flame controllers with infrared sensors (CFC 
x000IRx)! 

Not activated for the CFC 1000! 
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Standard display range (0 to 2500 mV) Modified display range (0 to 500 mV) 

3.4 Displaying the mA signal 
The 0/4 to 20 mA current output signal of the CFC is dis-
played as bargraph and percentage value on the left-hand 
side of the signal tab.  

3.5 Changing the scaling for the x and y axes 
The scaling of the x and y axes of the two diagrams for the 
analogue flame signal and the frequency signal can be 
freely selected. This is very helpful particularly when setting 
the sensitivities and the threshold values and for stretching 
and compressing the time axis. The final scale value can 
be marked with the help of the mouse, subsequently modi-
fied via the keyboard and confirmed with ENTER. Adjust-
ment of all values on this axis and in the graph is then per-
formed automatically. 
Comparison of the following two figures displays a possible 
change in view: 

The standard values are 2500 mV for the amplitude 
evaluation and DC raw signal evaluation as well as 200 
Hz for the frequency evaluation. 
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The maximum analogue flame signal is 2500 mV! A 
change in the scaling to higher values is not advisable. 

A longer display period can be set by changing the time 
axis. This is particular advantageous if changes in the sig-
nal are to be displayed over a prolonged period of time 
(e.g. burner start, change of fuel). 
To reset the axis scaling, refer to section 3.12. 

3.6 Switch-on delay 
The lower value with the designation ON in adjacent to 
the diagrams in the lower illustration indicates the quanti-
sation or starting delay time. As long as the flame signal 
has not exceeded the switch-on thresholds, the preset de-
lay value in seconds is displayed in this field.  
If the flame signal exceeds the switch-on thresholds, the 
time counts down to zero and then the flame relay is acti-
vated. Should the flame signal drop below the starting 
thresholds again before expiry of the set time, the time is 
reset again to the default value. The switch-on delay can 
be set to a value between 0.4 and 6 seconds. 
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3.7 Current starting value (SSW) 
The initial value of the current output is specified to 
0 or 4 mA here. 

3.8 Current relay function (SRF) 
The current relay function allows the analogue signal 
(current output) to be coupled with the flame relay. 
When the SRF is switched on, the current output is 
only enabled when the flame relay is activated. 

3.9 Variable lower current limit 
In addition, the compact flame controller allows se-
lection of the lower value of the analogue signal as 
a variable and therefore independent of the turn-off 
threshold (for a more detailed explanation, see sec-
tion 5.9). 

3.10 Displaying the parameters  

In addition to the respective current values for amplitude, 
frequency and DC raw signal, the corresponding switch-
on and switch-off thresholds can also be read. 
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3.11 Displaying the relay states 
The status of the flame and monitor relay is visualised via 
the LEDs arranged on the upper left. The flame relay is 
only driven when the "Flame" LED lights up bright green. 

The flame signal is evaluated in two separate channels. 
The monitor channel monitors the safety-related function 
of hardware and software and drives the monitor relay 
(M.Relay). The evaluation channel process of the flame 
signal is subject to the set software parameters and con-
trols the flame relay (F.Rely). Both channels must 
switched on simultaneously to activate the binary output 
signal (flame). 

The Flame ON binary signal is set when both relays are 
driven. The series connection of both relay contacts con-
forms to the SIL 3 requirements. 

3.12 Resetting axis scaling 
In the Window menu, the axis scaling can reset to the re-
spective default state with the Axis scaling menu item. 
This reset has no influence on the relevant settings for the 
flame monitoring. 

3.13 Diagram view 
It is possible to switch between the oscilloscope and flow 
diagram under Diagram view in the Window menu.  

Oscilloscope diagram Flow diagram 
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3.14 Shutter visualisation 
The shutter in the amplitude evaluation window can be 
visualised under Shutter Visualisation in the Window 
menu. 

3.15 Multiple display of different CFCs 
When several compact flame controllers are in use, it is 
possible to display up to four signals simultaneously. This 
function is activated with the Multiple display menu item in 
the Window menu. 
Each connected CFCx000 has a separate graph for visu-
alising its parameters. Selection takes place under the re-
spective menu items of the graphs. The selection of pa-
rameters for Graph 1 can been seen as follows. Exiting 
multiple display takes place by clicking Exit in the File 
menu. 

Connecting the compact flame controller for multiple dis-
play takes place via a standard USB hub.  

without shutter with shutter 



           Visualization 

3-11

3.16 Changing between Lite and Pro view  
 It is possible to display the CFC Com 1 programme in the 
Lite or Pro versions. 
In the Lite version, some setting options and displays are 
deactivated. However, the CFC can be fully parameter-
ized. 

In the Pro version, all displays and setting options are dis-
played. 
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Switching between both modes takes place under Win-
dow - > Lite/Pro or by clicking the red pro letters or the 
green letter on the user interface. 

It is possible to switch between both display formats in 
display mode. If it is necessary to switch between the pro 
to Lite display in comfort edit mode, an Info window ap-
pears that prompts you to exit the Edit section. It is only 
possible to change to the Lite view after pressing the "OK" 
or "Cancel" button. 
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4 Edit or input section 
The edit or input section is used to adjust the compact 
flame controller to the requirements of the combustion 
process. 
It consists of buttons and inputs fields, in which parame-
ters can be set or corresponding numerical values en-
tered. 

    Enable field       Info field 

4.1 Activating the edit section 
To enable the EDIT PARAMETER 1, EDIT PARAMETER 
2 or General sensitivity levels, the last two digits of the 
serial number of the connected compact flame controller 
must be entered into the Ser. Nr. enable field. The entire 
serial number can read on the type plate of the compact 
flame controller or in the Ser. No. info field and entered 
into the software. If the wrong serial number is entered, 
the Edit section remains locked and the input field flashes 
red. Input can be repeated as often as required. This 
serves as a safety barrier to prevent unintentional chang-
ing of parameters. 
The respective parameters are displayed for editing under 
the Edit Parameter1 and Edit Parameter 2 tabs.  
Changing the parameters of a non-activated parameter 
level is not possible but has no influence on the flame sig-
nal. The settings are activated only when the correspond-
ing level in the compact flame controller is selected. Acti-
vation of the second channel takes place via an exter-
nal control voltage of 24 V DC at pin 7 of the plug-in 
connector. 
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Parameter changes of a non-active channel are only ef-
fective after switch-over! It is necessary to check that the 
set parameters also ensure safe operation after switching 
over! 

4.2 Saving data on the microprocessor 
If settings are changed, the parameters are saved directly 
to the main memory (RAM). This is indicated by the mes-
sage Synchronising data set, please wait. 

The compact flame controller immediately operates with 
the new parameters which however, are not yet perma-
nently saved. 

Changed settings are initially buffered in the RAM of 
the compact flame controller and must be perma-
nently saved to the EEPROM by clicking the Save to 
µP button! 
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Parameters are only permanently saved in the EEPROM 
after pressing the µP key. If the parameters are not per-
manently saved, they will be lost after a loss of voltage.  

It is particularly useful that parameters are not saved per-
manently to the EEPROM when tests are performed since 
various different settings can be tested without the need 
to change the parameters saved in the EEPROM. When 
the voltage to the compact flame controller is switched off, 
the settings last saved in the EEPROM by pressing the 
µP button are applied. 

Save to µP button 
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4.3 Gain setting 
A change in the gain setting (sensitivity setting) influences 
the flame signal displayed with the amplitude evaluation. 
By default, the compact flame controller has the maximum 
gain of 32 (highest sensitivity). The gain setting can be 
read from the numerical value and at the slide controller. 
There are three ways of changing the gain: 
- With the mouse pointer via the UP/DOWN keys next to

the number value (1)
- Direct input of a value into the input field (2)
- By pressing the round button (3) next to the number

value, a further display is possible, in which, in addition
to options 1. and 2. there is the also following:
 To change the gain, move the mouse pointer

over the wide pointer of the slide controller and
press the left mouse key. Hold the mouse key
pressed and move the bar up or down. The ex-
act settings of the controller are also visualised
by the numerical value.

 The corresponding values are added or sub-
tracted directly to the gain number value via the
fixed value switches.

31 2



Edit or input section 

4-5

4.4 Amplitude evaluation 
The amplitude evaluation visualises the radiation modula-
tion of the measured flame radiation. It is an important pa-
rameter for flame monitoring. The current value and the 
corresponding switching thresholds are displayed in the 
window of the amplitude evaluation. 

4.4.1 Setting the switching threshold 

After starting the burner, the flame signal (black line) must 
intersect the green switching threshold from below. The 
flame relay is activated after the switch-on delay time has 
elapsed. This process must take place within the ignition 
safety time set at the burner controller. The switch-on and 
switch-off threshold can be modified within certain limits. 
The values for the thresholds are dependent on the flame 
signal and on the set sensitivity. The switch-on threshold 
must be set higher than the frequency of the extraneous 
light signal and lower than that of the own burner. If the 
burner is shut down or fails, the flame signal must drop 
clearly below the switch-off threshold.  

Signal above the switch-on threshold 

Signal below the switch-off threshold 
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Three are four different ways of setting the thresholds: 
- With the mouse pointer via the UP/DOWN keys next to

the number value (1)
- Direct input of a value into the input field (2)
- By pressing the round button (3) next to the number

value, a further display is possible:
 To change the switching thresholds, move the

mouse pointer over the wide pointer of the slide
controller and press the left mouse key. Hold
the mouse key pressed and move the bar up or
down. The exact settings of the controller is
also visualised by the numerical value.

 The corresponding values are added or sub-
tracted directly to the switching thresholds
value via the fixed value switches.

Min/Max values for the switch-on and switch-off thresh-
olds of the amplitude evaluation: 

ON min.                      650 mV 
max.        2200 mV 

OFF min.                      600 mV 
max.        1100 mV 

Default factory set-
ting 

ON = 1500 mV OFF = 800 mV 

The minimum difference between the switch-on and 
switch-off threshold is 26 mV. 

1 2 3
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4.5 Frequency evaluation 
In addition to the amplitude evaluation, the CFC 2000 
compact flame controller offers the option of performing 
frequency evaluation of the flame. The frequency evalua-
tion is subject to the modulation rate (flicker frequency) 
and was developed to eliminate the extraneous light in 
multi-burner systems. The flame signal of the flame to be 
monitored differs characteristically from other signal 
sources (extraneous light) by a higher flicker frequency. 

The frequency evaluation can not be activated for 
the CFC 1000. 

4.5.1 Activating the frequency evaluation 

Integration of the frequency evaluation into the flame 
monitoring takes place via the Frequency evaluation 
ON/OFF button. 

When the frequency evaluation is activated, the flame sig-
nal must exceed both the switch-on threshold of the am-
plitude evaluation and the switch-on threshold of the fre-
quency evaluation. Activation of the flame relay (Flame 
ON) takes place after the set switch-on delay. The flame 
relay remains active until one of both switch-off thresholds 
drops below the duration of the safety time. 

For switch-on and switch-off delays, refer to section 4.7. 
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4.5.2 Setting the switching thresholds 

The green values stands for the switch-on threshold, the 
red value for the switch-off value and the black value is 
the current value, the measured flicker frequency. 

The switch-on threshold must be set higher than the fre-
quency of the extraneous light and lower than that of the 
useful light. If the burner is shut down or fails, the fre-
quency signal must drop clearly below the switch-off 
threshold. 

Three are four different ways of setting the thresholds: 
- With the mouse pointer via the UP/DOWN keys next to

the number value
- Direct input of a value into the input field

 By pressing the round button next to the num-
ber value, a further display is possible:

 To change the frequency, move the mouse
pointer over the broad pointer of the slide con-
troller and press the left mouse key. Hold the
mouse key pressed and move the bar up or
down. The exact settings of the controller is
also visualised by the numerical value.

 The corresponding values are added or sub-
tracted directly to the switching thresholds
value via the fixed value switches.
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The minimum difference between the switch-on and 
switch-off threshold is 6 Hertz. 

ON min.                    11 
max.      250 

OFF min.                      5 
max.      200 

Default setting  ON = 40 OFF = 20 

Min/ Max values for the switch-on and switch-off thresh-
olds of the frequency evaluation 

4.6 DC raw signal evaluation 
The DC raw signal evaluation is only visualised on CFCs 
with IR sensors.

Not activated for the CFC 1000! 

4.6.1 Activating the DC raw signal evaluation 

Activation of the switching thresholds of the DC raw signal 
evaluation is currently not planned. 
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4.7 Safety times 

 Safety time for operation
(switch-off time)

The set safety time for operation applies to both sensitivity 
levels! 

The safety time can be adjusted to the safety speci-
fications of the system.  
Activate the corresponding field for the switch-off 
time by double clicking with the mouse and enter 
the new value via the keypad. Confirm with ENTER. 
The UP/DOWN switches are also available. 
The safety time operation can be set between 0.4 – 
6 seconds. 

The safety time for operation (switch-off time) is also sub-
ject to the hardware settings (refer to operating instruc-
tions BA CFC x000 DE). 

 Switch-on delay (switch-on time)

The flame signal must exceed to the switch-on 
thresholds for the set switch-on time in order for the 
flame relay to be activated. 
The switch-on time can be freely selected between 
0.4 and 6 seconds. The delay enables the compact 
flame controller to be optimally adjusted to the sys-
tem. 
Activate the corresponding field for the switch-on 
delay by double-clicking with the mouse and enter-
ing the new value via the keypad. Confirm the new 
value with ENTER. 
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4.8 Relationship between current limit value 
(20 mA) and amplitude evaluation 
The current output is formed from the signal of the ampli-
tude evaluation. If the amplitude of the radiation is in-
creased, the current of the analogue output is also in-
creased until the 20 mA mark is reached. This mark can 
be freely selected within the range of the amplitude evalu-
ation from the value of the switch-on threshold up to 2498 
mV. 
Switching over to the Current window display takes 
place by clicking the Current window switch. Acti-
vation of the current window is indicated by the 
bright green switch. In the amplitude evaluation win-
dow, the voltage value is represented as a red line 
from which the final current value is reached. The 
amplitude signal may not exceed this voltage value. 
The compact flame controller does not output more 
than 20 mA. 
The green bargraph displays the current output cur-
rent value. The blue bargraph displays the current 
amplitude signal. The middle bar with the slide con-
trollers display the set initial current value or final 
current value. The corresponding voltage values 
can read above and below the display. 
If an undefined value is confirmed, the previous value is 
set again. The setting can also be made with the 
UP/DOWN switched next to the numerical values. The va-
lues are changed in increments of 1. 

The initial current value is calculated automatically from 
Ivar (see section 4.9). 
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4.9 Variable lower current limit (Ivar) 
The switch-off threshold of the amplitude evaluation    in-
fluences the initial current value so that the analogue 
value of the switch-off threshold is at 25% of the final cur-
rent value (20 mA).  
In the case of an initial current value of 0 mA, the switch-
off threshold is at 5 mA.   
In the case of an initial current value of 4 mA, the switch-
off threshold is at 8 mA.   
If the final current is assigned another amplitude value 
(voltage) (section 4.8), automatic recalculation of the ini-
tial current value voltage takes place. 

By activating the Ivar ON function, it is possible to cancel 
automatic recalculation of the lower current mark. Cancel-
lation can take place in several ways: 
- Activating via the V-switch in the current window
- Activating the General switch Ivar ON tab
- Activating via the Options -> Lower current

threshold variable menu item

4.10 Current relay function (SRF) 
By default, the current output is only dependent on the 
amplitude evaluation of the flame modulation and the set 
current window. The switch-on thresholds have no influ-
ence on the current output.  
The current relay function offers the possibility of acti-
vating the current output only when the flame relay has 
picked up. Select Current relay function in the Options 
menu. The following window appears in which the rela-
tionship can be defined.  



Edit or input section 

4-13

4.11 Calibrating the current output 
On delivery, the CFC x000 is calibrated to an exact final 
current value of 20 mA. Should disruptive deviations oc-
cur, it is possible to calibrate the current output to the 
measured value acquisition system used. 
To calibrate the current output signal, click the Calibrate 
current output menu item in the Options menu. The fol-
lowing window opens: 

Dependence of the current output signal on the amplitude 
evaluation is cancelled. The final current value is set to 20 
mA. The measured value acquisition system should now 
display 20 mA irrespective of the amplitude evaluation. 
If the specified current is smaller than 20 mA, the red-
highlighted numerical value must continue to be increased 
until the control system detects 20 mA.  

If the specified current is greater than 20 mA, the red-
highlighted numerical value must continue to be de-
creased until the control system detects 20 mA.  

The value can be changed between 890 and 1022. To 
complete calibration, click the STOP switch.  
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If the compact flame controller is subsequently aligned to 
the flame and the amplitude evaluation signal is greater 
that the mark of the final current value, the control system 
must detect exactly 20 mA. 
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4.12 Fault memory 
The CFC x000 has an error memory that archives errors 
that have occurred and displays them in the Global sec-
tion. The last four errors are displayed according to the 
FiFo principle (First in First out).  
Fault memory 1 is the most recent error code. 

The following information is revealed by the error code. 
For example, the following figure shows a brief loss of 
voltage (BOT fault) with activated channel 1 at operating 
hour 320: 

      5       /       1       /       320 

    Error type            Error channel         Operating hour 

Error type Plain text Channel Operating hours 

1 RAM error Y zzzz 

2 Flame relay error 1 or 2 0 – 65535 

3 Electric potentiometer er-
ror 

4 Watchdog time error 

5 BOT error – Brown Out 
Detect 

1 or 2 0 – 65535 
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Error signaling is indicated via the red LED in the upper 
right part of the user interface. In addition, a signal is out-
put to PIN 8 of the plug-in connector. (see CFC operating 
instructions) 
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5 Data management 
The menu File contains two functions for data manage-
ment that simplify or support the work with the CFC x000 
compact flame controller. The parameters of the compact 
flame controller can be saved in a file and transferred to 
another compact flame controller. 
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5.1 Saving sensor parameters 
With the help of the Sensor param. save under... com-
mand, all relevant data and settings of the compact flame 
controller can be be saved to a file. Any target folder on 
the computer can be selected. 
The advantages of electronic data management are: 

 saving of the settings

 comparison and evaluation in offline mode

 transmitting of the data (evaluation by BFI-Service)

 transferring the settings to other devices

 possibility of documentation for operators

Only data already saved in the EEPROM of the compact 
flame controller with the Save to µP button is transferred 
to the hard disc! 

In addition to the setting data read from and saved directly 
to the EEPROM, the hardware setting can be noted be-
fore saving. 
The Frequency selection switch S1-1 or S1-2 input refers 
to the settings of the frequency filter, J1/J2/J3 bridged to 
the switch-off time of the safety channel. The J4 jumper 
specifies whether the input of the frequency analysis 
takes place before or after the high-pass. The current 
opening degree of the aperture can be noted in the optical 
aperture section. The compact flame controller is pre-
pared for relay wire fracture detection; this function is not 
active in the standard configuration. The serial number 
and the version can also be stored. 
System-specific data can also be recorded in this field. 
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After input has been confirmed with the OK button, the 
usual Windows Folder and file input window is opened 
and it is then possible to specify the storage location and 
the name of the file. 

5.2 Loading sensor parameters 
The saved parameters can be loaded onto the CFC x000 
from the computer with the Load sensor param. item in 
the File menu. The data is written directly to the 
EEPROM. 
For safety reasons, data can only be uploaded in Edit 
mode. 
An additional safety confirmation dialogue prevents unin-
tentional overwriting of the data. 
All previously set and stored data is lost when the new pa-
rameters are uploaded. 

Ensure that the hardware settings are also transferred ac-
cordingly! 

After installation on the burner, each new and preset com-
pact flame controller must be checked for proper function 
and security against extraneous light! 

5.3 Data logger 
The CFC x000 allows online saving of the detailed flame 
signal and the signal outputs on the computer. A space-
saving text file is used as file format.  
The maximum recording time depends on the size of the 
memory of the computer used. Approx. 3 MB per hour 
can be considered as a reference value. Data recording is 
started by clicking the Data logger button with the left 
mouse button. The shutter, which repeats every second, 
can be displayed or hidden via the menu. Hiding the shut-
ter is particularly helpful if the recording is to be evaluated 
graphically. The hardware settings and important system 
parameters can then be saved in the Notes field. Any tar-
get folder on the computer can be selected for the data 
logger file. 

Saved data logger files have the file designation 
Name.log. 
Files with the saved sensor parameters have the designa-
tion Name.par. 
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The active data logger can be recognised by the red but-
ton.  

Pressing the red OFF button deactivates the data logger 
again. Following that, a hardware settings query takes 
place as described in section 5.14. After input has been 
confirmed with the OK button, the usual Windows Folder 
and file input window is opened and it is then possible to 
specify the storage location and the name of the file. 
During recording of the data, comments can be entered 
that are the visible in the recorded file. For this purpose, 
the text is entered into the comment field and accepted by 
pressing the Add button. 

All recorded parameters can be imported into a spread-
sheet program for evaluation. 
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Notizen:

Frequenzwahlschalter 1+2 = ?0

Frequenzwahlschalter 3+4 = ?0

SJ3 gebrückt = ?5sec

Relaisdrahtbrucherkennung Aktiv = ?

Komplette  Typennummer = ? 1285

Ballastanteil 33%

Kohlefeuer ohne Öl

offene  Blende

Fühlerparameter CFC2000 :

Anal. Einschwelle=1001 Anal. Ausschwelle=750 Freq. Einschwelle=22 Freq. Ausschwelle=10

Roh. Einschwelle=549 Roh. Ausschwelle=249 Einschaltzeit1 1/10s=10 Verstärkung=32

Anal. Einschwelle2=1499 Anal. Ausschwelle2=1001 Freq. Einschwelle2=90 Freq. Ausschwelle2=70

Roh. Einschwelle2=601 Roh. Ausschwelle2=300 Einschaltzeit2 1/10s=10 Verstärkung2=10

Ausschaltz.1+2 1/10s=10 Chipnummer=188    CFC‐Versionsnummer=1,5 Betriebsstunden=25

Stromfenst. oben=2498 Stromfenst. unten=0 Kalib. Strom=908   Checksumme=175

Kanal Verknüpfung=Und DC‐Rohsignalbew.=Aus Frequenzbewertung=An Fehlerverh.=Flüchtig

Strom Rel. Funkt.=An

Zähler Ana. EZ.Ana. Frq. EZ.Frq. DC Roh. mA Verst. Fl.Rel. Mo.Rel. Stufe Fehler Zeit

29 2498 0 28 0 2434 20 32 1 1 1 0 10:14:50

30 2498 0 28 0 2434 20 32 1 1 1 0 10:14:50

14 2498 0 30 0 2434 20 32 1 1 1 0 10:14:50

15 2498 0 30 0 2434 20 32 1 1 1 0 10:14:50

16 2498 0 30 0 2434 20 32 1 1 1 0 10:14:50

A file from the data logger looks like this: 
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6 Faults 

Problem: Display: Cause: Remedy: 

Programme 
does not start 
communication 

CFC1000 start screen is 
not displayed. No 
changes on the screen 

No or the wrong interface 
selected 

Select the cor-
rect interface 

Evaluation sig-
nals stop 

No changes on the 
screen 

Communication between 
the CFC and the com-
puter interrupted 

Check connec-
tion, restart pro-
gramme 

Parameter file 
cannot be 
transmitted to 
the CFC 

Info window indicates 
that this function can 
only be executed in Edit 
mode. 

Edit mode must be 
switched for this function. 

Enter the serial 
number into this 
field and then 
transmit the pa-
rameter file to 
the device. 

Data logger 
does not start 

Error 8 occurs when ope-
ing/creating/replacing a 
file in the CFC2000.vi 

No access rights to the 
file in the C:\Program 
Files\CFC2000_Projekt\ 
data\*log.log path 

Execute this 
program as Ad-
min or at least 
have admin 
rights assigned 
to this path. 

Parameters 
cannot be chan-
ged 

Enable field for the 
serial number flashes 
red 

Wrong or no serial num-
ber entered 

Enter serial 
number 
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7 Order data 
The CFC Com1 software  can be obtained from BFI 
Automation Mindermann GmbH using the following or-
der data: 

Article Article number 

CFC Com1 communication 
software incl.       
IR/USB data interface ca-
ble, 1.5m 

6040-4901-00 

Accessories 

Article Article number 

IR/USB  
data Interface cable, 1.5m 

6040-4810-10 

IR/USB  
data Interface cable, 3m 

6040-4810-13 
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